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Schedule Pro

Appendix: Troubleshooting

1.2 Instroduction

Introduction

Congratulations on your purchase of Quarterback(TM), the best backup and
archival program for the Amiga. With Quarterback you can quickly and easily
safeguard all of your programs and documents from mishap.

Please read this manual in its entirety. While you cannot damage you hard
disk with Quarterback, you may put the contents of your disk at risk by not
understanding the operation of this program.

This introductory chapter outlines the basics of Quarterback. The sections
in this chapter are:

· Why Backup Your Data

· How To Use This Manual

· About Quarterback

· Backup Strategies

1.3 Why Backup Your Data

Why Backup Your Data

All hard disk backup software is based on the fact that all hard drives and
mass storage devices will fail. The question of device failure is not if,
but when. While hard drives of today are faster, more reliable, and less
expensive than those of ten years ago, all electronic equipment fails at some
point in it’s life.

If we could determine with accuracy the time and date of equipment failure,
then there would be no need for programs like Quarterback. Since we can’t,
we must rely on preventive measures such as making copies of the data on our
hard drives onto other media. With Quarterback, this media can be floppies,
magnetic tape, or any AmigaDOS compatible device.

Backup programs like Quarterback are essential to any regular maintenance that
you perform on your computer. When you clean the monitor of dust or wipe down
the keyboard or even clean the mouse, you are protecting your monetary
investment in your hardware. You should look at the effort you invest in your
creations, whether they be business data, creative writing, animations, ray
tracings, or fine art, as not just time but also creative effort as well.
As such, they deserve just as much, if not more protection as your hardware.
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1.4 How To Use This Manual

How To Use This Manual

This manual will help you get up and running with Quarterback as quickly as
possible. If you are new to the Amiga, be sure to read the next section
entitled "About Quarterback" and refer to the Introduction to Amiga manual
supplied by Commodore if necessary. There are four chapters in this manual:
Introduction, Using Quarterback, and Quarterback Reference.

This Introduction provides some basic program information about the Amiga
and Quarterback.

Using Quarterback describes each Quarterback operation in depth, allowing
you to take full advantage of its features.

Quarterback Reference is a quick-reference section that summarizes the menu
commands, keyboard equivalents, and other operations.

If You Don’t Read Anything Else

Make a copy of your Quarterback disk and store your original in a safe place!

You might find Quarterback to be so easy to use that you will be tempted to
set aside this manual and learn on your own. Whether you decide to learn
from the manual or learn by doing, you should take a look at the Shortcuts
section of the Quarterback Reference chapter to learn some time-saving key
commands that make more efficient use of Quarterback’s many features.

1.5 About Quarterback

About Quarterback

To use Quarterback, you will need to know how to use the Amiga computer.
You should already know how to:

· select and drag with a mouse
· use icons on the Workbench
· arrange windows using their front and back gadgets
· re-position and re-size windows using the title bar and sizing gadgets
· scroll a document by using scroll bars and scroll arrows
· use pull down menus and choose commands
· close windows with the close box

System Requirements

The minimum requirements for using Quarterback are an Amiga computer with
512K memory and version 1.2 or later of the Amiga’s operating system (also
called AmigaDOS), although Quarterback has several features available when
you are using version 2.0 or later of the AmigaDOS.

Quarterback can be run from either the command line interface (CLI) or the
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Workbench screen, and can optionally create icons when it saves. For more
information about the CLI, refer to your AmigaDOS User’s Manual.

1.6 Backup Strategies

Backup Strategies

Most of us hate to spend time backing up our hard disk drives. But we usually
learn through bad experiences just how necessary this really is. Fortunately,
Quarterback is designed to make this process as simple and painless as possible.

Incremental Backups

The quickest and easiest way to backup your data is to perform a full backup
only occasionally, perhaps once a week or once a month, and then use the
"incremental" backup features of Quarterback to backup only those files which
have changed since the last backup. Quarterback uses the "archive flag" in
the AmigaDOS directory to find new files or files which have changed since the
last backup.

The archive flag works this way: when you backup your files, you can tell
Quarterback to turn on this special "flag" for each file that is backed up.
This backup flag (called the "archive flag") indicates that a file has been
successfully backed up. The file is thus said to have been "archived". However,
when a new file is created, or if any changes are made to an existing file by
any program, AmigaDOS turns off the archive flag for that file.

The next time you perform a backup, you can have Quarterback backup only those
files which have the archive flag turned off, thereby only backing up the
files that are either new or have been changed since your last backup.

Incremental backup can only work if you have Quarterback turn on the archive
flag when you do your full backup. If you forget to have Quarterback to set
the archive flag, then later if you try to perform an incremental backup,
all your files will show up as needing to be backed up!

Another way to perform an incremental backup is to have Quarterback backup
files by file date - those which have a date later than the previous backup.

There are two schemes using the archive flag for incremental backups. The
two schemes differ in the number of sets of backup disks you must maintain,
and the speed of the backup. You should choose one of these schemes and
stick with it.

Incremental Backup Scheme I

This scheme uses only two sets of backup disks (one full, one incremental).
The advantage of this scheme is that it requires only two sets of backup disks.
The disadvantage is that, as time goes by, each incremental backup takes
longer and longer.

1. Once each month make a full backup of all your files on the hard disk
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to a "full backup" set of disks. For the full backup, make sure you
have Quarterback to set the archive flag. When the backup is complete,
put this "full backup" set of disks aside. You won’t use them again
until you perform another full backup next month.

2. Between full backups, perhaps once a week, perform an incremental
backup of all files which have changed since the full backup. Make
this backup to a different set of backup disks, the "incremental"Ó set.
Do not have Quarterback set the archive flag. This way you can do each
incremental backup to the same set of disks each time. By not setting
the archive flags, each incremental backup will backup the files which
have changed since the last full backup.

This backup scheme has the advantage that you have to maintain only two sets
of disks, and restore, at most, two sets of disks: the full set followed by
the incremental set. And to find the latest version of a particular file, you
have to check only two sets of disks.

Incremental Backup Scheme II

This scheme uses several sets of backup disks (one full, several incremental).
The advantage of this scheme is that each incremental backup contains only
files which have changed since the last backup, whether the last backup was a
full backup or an incremental backup. This scheme also works with file dates
as well as archive bits. The disadvantage of this scheme is that you must
maintain many sets of backup disks (many more than two).

1. Once each month make a full backup of all your files on the hard disk
to a "full backup" set of disks. For the full backup, make sure you
have Quarterback to set the archive flag. When the backup is complete,
put this "full backup" set of disks aside. You won’t use them again
until you perform another full backup next month.

2. Between full backups, perhaps once per week, perform an incremental
backup of all files which have changed since the last backup, whether
the last backup was the full backup or an incremental backup. Make
each incremental backup to a different set of backup disks. Do not
use the same backup disks for each incremental backup. Have Quarterback
set the archive flags. By setting the archive flags, each incremental
backup will backup the files which have changed since the last backup,
whether full or incremental.

This backup scheme has the advantage of speedy incremental backups. The
disadvantage is that you must maintain several sets of incremental backup
disks, which must be restored in the exact order they were created. And to
find the latest version of a particular file, you may have to search many sets
of backup disks.

Additional Suggestions

With either of these schemes, remember to save the archive report with each
set of disks so that you can easily find the latest version of a file.
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To ensure the integrity of your set of backup disks you should use the
"Verify data after write" option, at least the first time you use the disks.
However, this does slow down the backup process. As an alternative you could
pre-format your disks using the AmigaDOS "Format" program, which will also
find any bad disks.

You should also use alternate sets of full backup disks, so that you always
have another full backup set to go back to if one set turns out to be unusable.

1.7 Using Quarterback

Using Quarterback

This chapter will take you through all of the steps necessary to backup and
restore files using Quarterback. It also covers all of Quarterback’s advanced
features.

The sections in this chapter are:

· Getting Started

· Selecting

· Backing Up

· Restoring

· Advanced Features

· Program Settings

· Macros and AREXX

1.8 Getting Started

Getting Started

You should make a copy of your Quarterback disk to use while working. If you
are not familiar with copying a disk, see Commodore’s Introduction to Amiga
for instructions. Quarterback is not copy protected.

Display Options

Quarterback will normally use the Workbench screen for its window and
requesters. However, you can override this and specify any screen mode and
number of colors that the Amiga is capable of providing. When using
Workbench 2.0, you can even have Quarterback use another program’s screen if
that program declares its screen as "Public".



qbhelp 7 / 54

You specify display options when you first start the program. To specify a
display option from the Workbench, you must add one or more of the following
options to Quarterback’s "Tool type" list. To specify a display option from
the CLI, simply type a dash (-) and the option as a command parameter. Most
options have both an abbreviated and a full form. The options supported by
Quarterback are:

"HighRes" or "HR"
Use a 640 by 400 screen (640 by 512 in PAL).

"MedRes" or "MR"
Use a 640 by 200 screen (640 by 256 in PAL).

"LoRes" or "LR"
Use a 320 by 200 screen (320 by 256 in PAL). Using a low resolution screen
may require the use of shortcuts to access some requester items, as some
requesters may be too large to completely fit the screen.

"Productivity" or "PR"
Use a productivity mode screen (640 by 480 non-interlaced). This option
requires AmigaDOS 2.0, the enhanced chip set, and a VGA or multisync monitor.
This mode only supports two and four color screens.

"SuperHiRes" or "SR"
Use a super high resolution mode screen (1280 by 400). This option requires
AmigaDOS 2.0 and the enhanced chip set. This mode only supports two and four
color screens.

"Colors:number" or "Colors=number"
Where number is 2, 4, 8, 16, or 32. This command specifies the number of
colors that the screen is to use. Note that 32 colors can only be used with
low resolution screens (see the "LoRes" option above). You can also use a
spelling of "Colours" for this command.

"Screen:screen name" or "Screen=screen name"
Where screen name is the name of an existing public screen. This option
requires AmigaDOS 2.0, and the presence of a public screen with the given
name. Examples of screen names are "Workbench" for the Workbench’s screen,
and "ProWrite" for ProWrite’s screen (ProWrite is a word processor from New
Horizons Software, Inc.). This option overrides other screen options. When
Quarterback opens its own screen, it declares it a public screen with the
name of "Quarterback".

"SmartWindows" or "SW"
Use "smart refresh" windows. This option makes window displays slightly faster
when dealing with several overlapping windows, at the expense of consuming
more memory.

"DumbWindows" or "DW"
Use "simple refresh" (i.e., non-smart refresh) windows. Quarterback 6.0 now
defaults to using smart refresh windows, use this option to disable this
default. This option makes window displays slightly slower when dealing
with several overlapping windows, but uses less graphics memory.

"ASL"
Use the "ASL" file requesters for choosing files to open or save. This option
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only works with Kickstart 2.0 or later, and only if the "asl.library" file is
installed on your Amiga. Note that since there is no way for Quarterback to
add its own buttons to the ASL requesters, all saves will be done in their
default format.

"NoSCSI" or "NS"
Disables all SCSI I/O. When Quarterback starts up, it normally polls all
SCSI devices attached to your computer to see which ones are tape drives. This
way it can automatically select the first tape drive it finds as the default
tape device (unless you have saved a preferred setting that overrides this).
However, some older SCSI controllers do not properly handle this initial
inquiry stage, and some older SCSI devices may not properly respond. If
Quarterback seems to lock up when you start it, you can disable this SCSI
inquiry, and all other SCSI I/O by including this start-up option. Most users
will never need to use this option.

"NoAutosense" or "NA"
Disable SCSI autosense commands. The SCSI command set provides for having
devices automatically responding to error conditions, rather than waiting for
the computer to ask them about errors. This is called "Autosense", and
Quarterback uses this feature to speed its SCSI I/O. However, some older
SCSI controllers do not properly handle autosense commands, and may lock up
your Amiga when they are used. If you are experiencing erratic behavior when
using tape drives, you may need to use this start-up option. Most users will
never need to use this option.

If you are starting Quarterback from the CLI, you can specify a command
argument to Quarterback. There are several types of command arguments you can
supply, and Quarterback’s start-up behavior differs depending upon the type
of argument you specify:

· If you specify a path name as an argument, Quarterback will prepare
to backup the files in that location, just as if you had selected that
location and clicked on the "Backup" button.

· If you specify a preferences file name as an argument, Quarterback
will load those preferences settings instead of the default settings.

· If you specify an AREXX macro as an argument, Quarterback will begin
executing that macro instead of the default "QB Startup" macro. Any
additional arguments on the command line will be passed to the macro,
and will not be examined by Quarterback. For example, if you have a
macro named "Backup" in your "Macros" drawer, and you start Quarterback
by typing:

Quarterback Backup Work:

Then after Quarterback starts it will immediately begin executing the
macro named "Backup" and pass the parameter "Work:" to the macro.

Starting Quarterback

You can load and use Quarterback from either the Workbench screen or from a
CLI window.
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To load Quarterback:
· Insert your copy of your Quarterback disk into a disk drive.

· From the Workbench: double click on the Quarterback program icon.

· From the CLI: type "Quarterback" (and optionally, any display options)
and press return.

In a few moments, Quarterback will display copyright information on your
Workbench screen, or a screen of its own if you have told it to use a custom
screen with a start-up parameter (see the section entitled About Quarterback
in the Introduction for information about start-up parameters). Quarterback
will display this information while it obtains information about your system.
Once Quarterback is done obtaining this information, it will display its main
window.

Quarterback’s main window is divided into two parts: the Control Panel on the
left, which contains information displays and buttons for controlling
Quarterback, and the Display List on the right, where Quarterback displays disk
lists, file catalogs, and session logs. Quarterback also has several pull-down
menus which contain commands that you can use to customize and control its
operation.

In the display list there are miniature icons next to each disk, drawer, or
file name. These icons identify the type of item:

· Floppy disk and hard disk icons for disks.

· Drawer icons for drawers

· Document icons for files

Quarterback also supports both hard and soft "links", which are a new feature
of AmigaDOS 2.0. Hard and soft links will be displayed with a gray icon, and
their name will be in italics.

Initially, Quarterback displays a list of available disks (also called "Volumes")
on the right, and has the four buttons "Backup", "Restore", "Enter", and "Back"
in the control panel.

1.9 Selecting

Selecting

Many Quarterback operations require you to select items or locations from the
display list. For example, before you can begin a backup or restore operation,
you must first select the disk or drawer you wish to use. For backing up, this
is the location of the files you wish to backup. For restoring, this is the
location to which the files will be restored.

Selecting Items

You can select items in the display list with either the mouse or keyboard. A
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selected item will be displayed with light-colored text on a dark background.

To select an item in the display:
· Move the mouse pointer over the item you wish to select, and click once

with the left mouse button.

· Use the up and down cursor keys to move the highlighting over the item
you wish to select.

Since you can only backup or restore from one location at a time, Quarterback’s
start-up display only lets you select one item at a time. At other times,
however, it is possible to select multiple items in the display. There are
several ways that Quarterback lets you do this.

To select several items in the display:
· Click on the first item you wish to select, then hold down the shift

key and continue clicking on each additional item you wish to select.
Shift-click on a selected item to de-select it.

· Click and drag in the display to select a range of items.

· Hold down the shift key and use the cursor up and down keys to select a
range of items.

At most times, you can enter into disks and drawers to display and select their
contents. You can do this whenever the "Enter" and "Back" buttons are available
in the control panel. Again, Quarterback provides you with several ways of
doing this.

To display disk and drawer contents:
· To enter a disk or drawer, select it in the list and click on the

"Enter" button, or simply double-click on it.

· To go back out to the previous level you were displaying, click on the
"Back" button.

· To go back out to the top level (to the list of disks in the initial
window, or the root of the location you are backing up or restoring),
hold down the alt key and click on the "Back" button (its name will
change to "Root" when you hold down the alt key).

Displaying Assigned Directories

You can backup from or restore files to either a disk or a drawer on a disk.
For advanced users, you can also choose to restore to an "assigned" location.
To do this, you first must have Quarterback display assigned directories in
the initial volume list.

To display assigned directories in the volume list:
· Choose Preferences from the Options menu. A requester will appear.

· Turn on the "Include assigned directories in list of volumes" check box.

· Click the "OK" button.



qbhelp 11 / 54

1.10 Backing Up

Backing Up

With Quarterback, you can backup either a group of files or the contents of
an entire disk. You can back these up to several locations: one or more floppy
disks, a computer tape, a high-capacity removable disk such as a SyQuest or
floptical disk, or to an AmigaDOS file. To save space you can even choose to
compress the files during the backup.

In a complete backup, Quarterback will read the disk catalog and proceed
immediately to the backup display, bypassing the file selection mode. If you
are backing up all of the files on your disk this will make working with
Quarterback faster and more convenient.

Selecting a Backup Source

The first step in backing up your files is to select the location which
contains the files you wish to backup.

To select a backup source:
· Select the disk or drawer from which you wish to backup.

· Click on the "Backup" button.

At this point, Quarterback will then allow you to select your backup options
(unless you don’t have "Display this requester before volume scanned" check
box selected in the "Backup Options" requester).

Setting the Backup Destination

Once you click on the "Backup" button, the "Backup Options" requester will
appear (unless you have disabled the requester display). This is the same
requester which appears when you choose Backup Options from the Options menu,
and is here where you specify the destination and other options for your
backup.

To set the backup type:
· To make a complete backup of the source disk or drawer, select

the "Complete" button. In a complete backup, Quarterback will read
the disk catalog and proceed immediately to the backup display,
bypassing the file selection mode. If you are backing up all of
the files on your disk this will make working with Quarterback
faster and more convenient.

· To select which files you wish to backup, select the "Selective"
button. The file selection display will be shown after the disk
catalog has been read.

To set the backup destination:
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· To backup to floppy disks, select the "Floppy drives" button and turn
on the check boxes for the floppy drives that you will be using.
Quarterback supports up to four floppy drives, labeled "DF0:" through
"DF3:". If a floppy drive is not attached to your system, its name and
check box will be disabled.

· To backup to a tape drive or removable drive, select the
"Tapes/Removables" button and select the device driver and unit number
for the drive you will be using.

· Use the arrow buttons next to the device text box to switch among
device drivers that are currently installed on your system. Use the
"scsi.device" for SCSI devices attached to an Amiga 3000 computer. For
other SCSI interface boards, refer to the manufacturer’s information
to determine which device driver to use.

· Use the arrow buttons next to the unit text box, or type a unit number,
to select the unit number to use. Most SCSI device unit numbers must be
between 0 and 7. If a SCSI device of the specified unit number is
attached to your system, its internal identifying information will be
displayed near the top of the requester; otherwise, Quarterback will
display the message "Device not found".

· To backup to an AmigaDOS file, select the "AmigaDOS file" button and
either type the path and file name in the text box, or click on the "?"
button and use Quarterback’s file requester to specify a file name and
location.

· To have the "Backup Options" requester automatically appear each time
you begin a backup, turn on the "Display this requester before backup
begins" check box. If you always use the same backup destination and
options, and have saved these settings as your default (see Preferences
later in this chapter), then you can turn this option off.

Quarterback provides you with several options for the backup. Some of these
options help decrease the destination size requirements (compression) or
ensure the integrity of your backup (verification) at the expense of slowing
down the backup operation. Click the "More..." button to access a sub-requester
to alter these options.

To set backup options:
· To compress the output, turn on the "Use" check box under "Compression"

and specify the compression type you want (12 bit through 16 bit). For
more information on compression, see the Advanced Features section of
this chapter.

· To enable tape drive built-in hardware compression, select "Use device
compression" under "Compression" It is discussed in the section on
tape handling.

· To protect your backup data from others, turn on the "Password
protection" check box. For more information on password protection, see
the Advanced Features section of this chapter.

· To have the "archive" flag set on all files that are backed up, turn on
the "Set archive flag" check box. This will slow down the backup
somewhat, but will make it easier to determine which files have already
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been backed up so that future backups need only backup new files.

· To verify the data after it is written, turn on the "Verify data after
write" check box. This will make the backup run about half as fast as
otherwise, but will ensure that the backup set is readable and
identical to the source.

· To have Quarterback warn you if you insert a floppy that has already
been formatted by AmigaDOS, turn on the "Warn if destination is an
AmigaDOS volume" check box. This will ensure that you don’t
accidentally erase important information on your floppy disks.

· If you turn on the "Backup entire directory structure" check box,
Quarterback will make a backup of the entire directory structure of
the disk even if you are backing up only a few files from the disk.
This is generally a safer thing to do, since you can have the restore
operation not restore the entire directory structure even if you have
backed it up. However, if you wish to disable this feature you can
turn this check box off.

Once you have specified the backup destination and backup options you wish to
use, click on the "OK" button. If you have "Selective" Backup Type selected,
Quarterback will start building a catalog of all of the files contained in the
location you selected. On large hard disks or network devices, this may take
several minutes. If "Complete" Backup Type is selected, only the last
section in this chapter will now apply - Performing the Backup.

Setting the Catalog Options

Once the catalog is built, Quarterback will display the files and drawers in
the top-most level. You can display the contents of drawers by using the "Enter"
and "Back" buttons just as you did with the initial start-up display.
Quarterback’s catalog contains a wealth of information about the files and
drawers in the backup location. You can control what information Quarterback
displays.

To set catalog options:
· Choose Catalog Options from the Options menu. A requester will appear.

· To have the catalog display file sizes, turn on the "File size" check box.

· To have protection flags displayed, turn on the "Protection flags"
check box.

· To have file creation/modification dates displayed, turn on the "Date
modified" check box.

· To have file creation/modification times displayed, turn on the "Time
modified" check box.

· To sort the list alphabetically by file name, select the "Name" button.

· To sort by file size, select the "Size" button.



qbhelp 14 / 54

· To sort by creation/modification date, select the "Date" button.

· To have drawers grouped together at the top of the list, turn on the
"Group drawers first" check box. If this option is turned off, drawers
will be sorted in with the file names.

· To have the time displayed with seconds, turn on the "Show seconds"
check box.

· To have the time shown with AM/PM indicators, turn on the "Show AM/PM"
check box. If this option is turned off, the time will be shown in a
24-hour format.

· Select the date format you prefer from the list provided.

· Once you have selected the catalog options you prefer, click on the
"OK" button.

Selecting the Files to Backup

Initially, every file in the catalog will be "tagged" for backup; i.e. it will
have a check mark next to its icon. Only tagged files will be backed up. At
this point, you can either proceed to backup all of the files, or, if you wish
to backup only some of the files, tag only those files you wish to have backed up.

To tag and untag files:
· To tag files, select the files you wish to tag and click the "Tag"

button, or choose Tag Selection from the Tag menu. When you tag a
drawer, all files contained within that drawer will be tagged.

· To untag files, select the files you wish to untag and click the "Untag"
button, or choose Untag Selection from the Tag menu. When you untag a
drawer, all files contained within that drawer will be untagged.

· To tag or untag a single file, double-click on the file. If the file
was initially tagged, it will be untagged. If it was initially untagged,
it will be tagged.

· To tag all files from the current directory level down, hold down the
alt key and click on the "Tag" button (its name will change to "Tag All"
when you hold down the alt key), or choose Tag All from the Tag menu.

· To untag all files from the current directory level down, hold down the
alt key and click on the "Untag" button (its name will change to "Untag
All" when you hold down the alt key), or choose Untag All from the Tag
menu.

Quarterback also offers powerful options for tagging and untagging files based
upon several criteria. You use Quarterback’s "Tag Filter" for this.

To use the Tag Filter:
· Choose Tag Filter from the Tag menu. A requester will appear.

· To untag (exclude) files with the tag filter, select the "Exclude"
button. To tag (include) files, select the "Include" button.
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· To untag files that have their "archive" flag set (or tag files that do
not have it set), turn on the "Files with Archive flag set/not set"
check box. The archive flag is a file attribute that Quarterback can
set when it backs up a file, which indicates that the file has been
backed up. Whenever a program modifies a file, the archive flag is
automatically turned off.

· To tag or untag files that were created or modified on or before a
certain date, turn on the "Files modified on or before" check box and
enter the date in the text boxes (or use the arrow buttons to set the
date).

· To tag or untag files that were created or modified on or after a
certain date, turn on the "Files modified on or before" check box and
enter the date in the text boxes (or use the arrow buttons to set the
date).

· To tag or untag files that match one or more AmigaDOS pattern matching
criteria, turn on the "Files matching:" check box and enter one or more
patterns in the pattern list.

· To add a pattern to the list, type the pattern in the text box and click
on the "Add" button, or press the return key.

· To remove a pattern from the list, select the pattern and click on the
"Remove" button.

· To load a list of patterns from a file, click on the "Load" button and
locate the pattern file. A pattern file is a plain text file containing
one pattern per line.

· To save your pattern list for later use, click on the "Save" button and
specify a name and location for the pattern file.

You specify file name patterns with standard AmigaDOS "wildcards". Under
AmigaDOS 1.2 and 1.3, only the "?" and "#?" wildcards are supported; the "?"
wildcard will match any single character in that location, while the "#?"
wildcard will match any number of characters in that location. For example, the
pattern "a?c" will match file names of "abc", "aac", "a3c", and so on, while
the pattern "a#?c" will match "ac", "abc", "axyzc", and so on.

Under AmigaDOS 2.0, the entire standard Amiga wildcard system is supported.
Refer to your AmigaDOS User’s Manual for complete information about the pattern
matching wildcards.

Quarterback can also automatically load and apply a tag filter pattern list
whenever you begin a backup session. See the Advanced Features section for more
information on automatic tag filters.

· If you wish to have your filter criteria tag or untag files only in the
current drawer, turn on the "Apply only to files in current drawer"
check box. Otherwise, Quarterback will tag or untag files in the
current drawer and all drawers below, based upon your tag filter settings.

· To apply your tag filter, click on the "Tag" (or "Untag") button.

When a file is tagged, it will have a check mark next to its icon. When the
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entire contents of a drawer are tagged, it will also have a check mark next to
its icon. When some, but not all, of a drawer’s contents are tagged, there will
be a dash (-) next to its icon.

In the control panel, Quarterback displays the number of files and the total
size in bytes of all tagged files, as well as for all files in the catalog. You
can use this to gauge how many floppy disks you will need for the backup (if
you are backing up to floppies), and how long it will take.

Setting the Session Log Options

After you have tagged the files for backup, set the backup destination, and
backup options, you are ready to proceed with the backup. While performing a
backup, Quarterback will keep a log of the files backed up during this session.
This log will be displayed in the list as the backup progresses, and can be
either automatically or manually saved, or printed, after the backup is
complete. You can set several options for controlling this session log.

To set the session log options:
· Choose Session Log Options from the Options menu. A requester will

appear.

· To have only errors displayed and saved in the session log, select the
"Errors only" button.

· To have errors and drawer names displayed and saved, select the "Errors,
drawer names" button.

· To have errors, drawer names, and file names displayed and saved, select
the "Errors, drawer names and file names" button.

· To have information about the average backup rate in megabytes per
minute included in the session log, turn on the "Rate in megabytes per
minute" check box.

· To have information about the average compression efficiency (when
compression is turned on) included in the session log, turn on the
"Compression efficiency" check box.

· To keep the session log from being updated while a backup is in
progress, turn on the "No display while operation in progress" check box.

· To have no session log saved, select the "No session log file" button.
You will still be able to manually save the session log after the backup
is complete.

· To automatically save the session log with a default name (that includes
the current time as part of the name), select the "Save as default
time-stamped file name" button.

· To automatically save the session log with a name you supply, select the
"Save as" button and either type a path and file name in the text box,
or click on the "?" button and use Quarterback’s file requester to
specify a location and file name.

· After you have set all of the session log options, click on the "OK"
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button.

Since the session log is constantly displayed and updated while the backup is
in progress, it does slightly slow down the backup operation. For the fastest
backup speed, turn on the "No display while operation in progress" check box.
When you do this the display will only be updated when you pause the backup,
or when there is an error.

Performing the Backup

Once you have set all of the options to the way you want them, you are ready to
perform the backup. To begin the backup, click on the "Start" button. If you
are backing up to floppies, Quarterback will prompt you to insert floppy disks
into the drives when it needs them. For backing up to a tape or file,
Quarterback will prompt you for a tape if it needs one, and begin the backup.

During floppy backups, the control panel will indicate which drive is currently
in use, which are waiting for you to remove the disk and insert a new one, and
which have a disk and are ready. If you are using more than one floppy drive,
then by using these indicators you can make sure that Quarterback always has a
disk ready for writing. Using these indicators will decrease the amount of time
you spend backing up, by eliminating the need for Quarterback to prompt for a
new disk.

While a backup is in progress, Quarterback will display the number of files
backed up, the number of bytes backed up, and the percentage complete. The
display list will show the session log as files are backed up, so you can see
at all times how far along you are in the backup operation.

You can pause the backup at any time by clicking on the "Pause" button. While
the backup is paused you can change some settings such as the session log
options. Click "Resume" to continue. You can abort the backup completely by
clicking on the "Abort" button.

Once the backup is complete, you can examine, save, or print the session log.
See the Advanced Features section for information on saving and printing the
session log. Click on the "Done" button when you have finished with the session
log; you will be returned to Quarterback’s initial start-up display.

1.11 Restoring

Restoring

Restoring your data from a backup set is very similar in operation to backing
it up. To restore your data you simply select a restore destination, select
the restore type, specify where the backup set is located, select the files
you want to restore, and proceed.

With Quarterback, you can restore your data to any location; you do not have
to restore your data to the same location from which you backed it up. You can
also choose to restore only a few of the files in the backup set rather than
the entire catalog of files. These features make Quarterback ideal for
archiving your data - you can make a backup of files that you seldom use, then
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retrieve each file individually whenever you need them.

When restoring with Quarterback, many of the features available during backup,
such as tag filters, catalog options, session log options, and so forth, are
also available during restore operations. Refer to the Backing Up section of
this chapter for more information on these features.

Setting the Restore Destination

The first step in restoring from a backup set is to select the location to
which you wish to restore your files.

To select a restore destination:
· Select the disk or drawer to which you wish to restore.

· Click on the "Restore" button.

Selecting the Restore Source

Once you have specified the destination for the restore, Quarterback will
display the "Restore Options" requester. This is the same requester which
appears when you choose Restore Options from the Options menu, and is where
you specify the location of the backup set from which you are restoring.

To select restore type:
· To restore your backup to the selected destination, select "Restore"

beside "Restore type".

· To read the backup set and verify against the contents of your disk
without restoring the data, select the "Compare" option beside
"Restore type".

· To test the backup set for data integrity, select the "Test" option
beside "Restore type".

To select the restore source:
· To restore from floppy disks, select the "Floppy drives" button and

turn on the check boxes for the floppy drives that you will be using.
Quarterback supports up to four floppy drives, labeled "DF0:" through
"DF3:". If a floppy drive is not attached to your system, its name and
check box will be disabled.

· To restore from a tape drive or removable drive, select the
"Tapes/Removables" button and select the device driver and unit number
for the drive you will be using.

· Use the arrow buttons next to the device text box to switch among
device drivers that are currently installed on your system. Use the
"scsi.device" for SCSI devices attached to an Amiga 3000 computer.
For other SCSI interface boards, refer to the manufacturer’s
information to determine which device driver to use.

· Use the arrow buttons next to the unit text box, or type a unit number,
to select the unit number to use. Most SCSI device unit numbers must be
between 0 and 7. If a SCSI device of the specified unit number is
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attached to your system, its internal identifying information will be
displayed near the top of the requester; otherwise, Quarterback will
display the message "Device not found".

· To restore from an AmigaDOS file, select the "AmigaDOS file" button
and either type the path and file name in the text box, or click on the
"?" button and use Quarterback’s file requester to specify a file name
and location.

· To have the "Restore Options" requester automatically appear each time
you begin a restore, turn on the "Display this requester before restore
begins" check box. If you always use the same restore source and
options, and have saved these settings as your default (see Preferences
later in this chapter), then you can turn this option off.

Quarterback provides you with several options for restoring. You should choose
the options you are most comfortable with. Click the "More..." button to access
a sub-requester to alter these options.

To set restore options:

· The "Replace earlier versions" setting controls whether Quarterback
will automatically replace existing files that are older than the
one in the backup set. Choosing "Yes" will have replacements
always occur, choosing "No" will have them never occur, and
choosing "Prompt" will have Quarterback ask you for each file that
already exists whether or not to replace it.

· The "Replace later versions" setting controls replacing existing
files that are newer than the one in the backup set. The setting
for this option works in the same way as above.

· Specify the date to which you want Quarterback to set the restored
files’ creation/modification dates. You can have Quarterback set it to
the file’s original date by selecting the "Original" button, to the date
the backup set was created by selecting the "Backup" button, or to the
current system date by selecting the "Current" button.

· To have Quarterback restore all drawers in the backup set, even if they
are empty, turn on the "Restore empty drawers" check box. This will
cause Quarterback to restore everything to the exact state it was when
backed up.

· To have Quarterback set the archive flag on files it restores, turn on
the "Restore archive flags" check box.

· To have Quarterback restore the entire directory structure exactly as
it was backed up, turn on the "Keep directory structure of restored
data" check box. If you turn this check box off, Quarterback will
restore all the files you select to the same location, which is useful
if you are using Quarterback to archive your files.

Once you have specified the restore source and restore options you wish to use,
click on the "OK" button.

At this point, Quarterback will read the catalog from the backup set you have
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selected. Initially, every file in the catalog will be tagged for restore. If
you do not want every file restored, you should use the tag functions to tag
just those files you wish to have restored. Tagging and untagging files operates
just like when backing up, see the Selecting the Files to Backup section of this
chapter for more information on tagging and untagging files. Once you have
tagged all of the files you wish to restore, click on the "Proceed" button.

Performing the Restore

Once you have set all options to the way you want them, you are ready to
perform the restore. To begin the restore, click on the "Start" button. If you
are restoring from floppies, Quarterback will prompt you to insert a floppy
disk into a drive when it needs one. For restoring from a tape or file,
Quarterback will simply begin the backup.

During floppy restores, the control panel will indicate which drive is
currently in use, which are waiting for you to remove the disk and insert a
new one, and which have a disk and are ready. If you are using more than one
floppy drive, then by using these indicators you can make sure that
Quarterback always has a disk ready for writing. Using these indicators will
decrease the amount of time you spend restoring by eliminating the need for
Quarterback to prompt for a new disk.

While a restore is in progress, Quarterback will display the number of files
restored, the number of bytes restored, and the percentage complete. The
display list will show the session log as files are restored, so you can see at
all times how far along you are in the restore operation.

You can pause the restore at any time by clicking on the "Pause" button. While
the restore is paused, you can change some settings such as the session log
options. Click "Resume" to continue. You can abort the restore completely by
clicking on the "Abort" button.

Once the restore is complete, you can examine, save, or print the session log.
See the Advanced Features section for information on saving and printing the
session log. Click on the "Done" button when you have finished with the session
log; you will be returned to Quarterback’s initial start-up display.

Secondary Catalog

When backing up to direct-access removable media (i.e., floppy disks or
removable cartridges), Quarterback automatically writes the file catalog to
both the beginning and end of the backup session. If, when restoring, the
catalog at the beginning is unreadable, Quarterback will ask you to insert the
last disk in the session so it can use the secondary catalog. If for any reason
you wish to force Quarterback to use the secondary catalog, you can do this by
holding down the alt key when you click on the "Restore" button.

1.12 Advanced Features

Advanced Features

Quarterback has several advanced features for managing your backup and restore
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operations. These features range from being able to save and print session
logs and file catalogs, to file compression, password protection of your data,
and even direct control of tape drives.

Saving and Printing Catalogs and Session Logs

When viewing the file catalog or backup/restore session log in the display list,
you can save and print them as well. The commands on the project menu for
saving and printing will change according to whether you are currently viewing
the catalog or session log.

To save a catalog or session log:
· Choose Save Catalog As or Save Session Log As from the Project menu.

A requester will appear.

· Specify a location for the catalog or session log by using the "Enter",
"Back" or "Disk" buttons.

· Type a name for the catalog or session log type typing in the text box.

· If you are saving a catalog, select the format in which you wish to have
it saved.

· Select the "Normal" button for a "list-style" format that saves complete
file information. This format saves the file similarly to the way it is
displayed in the display list, except that information about all files
in the catalog is saved rather than just those files in the current
drawer.

· Select the "Hierarchical" button to save as a tab-indented format with
file names only. This format will simulate the hierarchical format of
the catalog by having tab characters inserted before each file name
with the number of tabs corresponding to the depth of the file in the
file system hierarchy. This format is particularly useful for use with
programs such as Flow from New Horizons Software, Inc., which can let
you selectively show only portions of tab-indented files.

· When you have chosen the format, location, and name for the file, click
on the "Save" button to save the file.

You can also print the catalog or session log you are viewing. Before printing,
it may be necessary to save the page format you wish to use. If you do not
specify a page format, Quarterback will use its current default settings.

To specify the page format:
· Choose Page Setup from the Project menu. A requester will appear.

· Select the paper size from the list presented. The possibilities are
"US Letter", "US Legal", "A4 Letter" (an international letter size),
and "Wide carriage" (for wide-platen printers). A "Custom" option is
also available, with associated text boxes for entering a custom page
size in inches (or centimeters if you have the unit of measurement set
to centimeters).

· Select the printer pitch you want to use. The choices are "Pica"
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(10 cpi), "Elite" (12 cpi), or "Condensed" (approximately 17 cpi on
most printers). Note that some printers use a different pitch for
"Condensed" than what Quarterback expects, which may affect the output
quality when using this pitch.

· Select the line spacing you want to use. The choices are "6 lpi" or
"8 lpi".

· Select the unit of measurement you want to use for the "Custom" page
size. The choices are "Inches" or "Centimeters".

· Select or deselect the "No Gaps Between Pages" option, as desired.
When turned off, Quarterback will not print on the top or bottom 1/2
inch of the page.

· Click on the "OK" button to set the page format.

Once you have set the page format, you can print the catalog or session log.
Quarterback can print either in "NLQ" or "Draft" modes. NLQ mode will give you
the best quality output, but is slower than Draft mode. Also, some printers
are not capable of printing Condensed pitch in NLQ mode.

To print a catalog or session log:
· Make sure your printer is properly connected to your computer and turned

on.

· Make sure the paper is properly positioned in the printer. If you have
the "No Gaps Between Pages" option in the "Page Setup" requester turned
off, then position the top edge of the paper 1/2 inch above the top of
the print head. If you have this option turned on, position the top
edge of the paper at the top of the print head (so the first line
printed will be on the very top of the page).

· Choose Print Catalog or Print Session Log from the Project menu. A
requester will appear.

· Select the print quality you want, either "NLQ" or "Draft".

· If you want more than one copy of your document, type the number of
copies in the "Copies" text box.

· Specify whether you will be using "Automatic" or "Hand feed" paper
feed. If you select "Hand feed" you will be prompted for the next sheet
of paper whenever each page finishes printing.

· Set the desired printer font number. This number’s meaning depends on
your printer driver, and not all printer drivers currently support it.

· If you wish to print the document to a file, click on "File" for the
destination.

· Click on the "Print" (or "Save") button to begin printing. If you are
printing to a file, the Save As requester will appear where you can
specify the name and location of the file you are creating.
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When printing begins, a requester will appear allowing you to cancel the
printing at any time.

When printing to a file, Quarterback saves all printer control sequences as
Amiga printer commands, not as the destination printer’s commands. This means
that to print the file you have created, you must copy it to "PRT:" rather
than "PAR:" or "SER:".

Session Information

With Quarterback you can add descriptive information to your backup sets. You
can name the backup and add any comments that will help you identify the
particular backup. When Quarterback shows you this information during a restore,
it also tells you the source location of the backup and the date that the
backup was made. You can use this information to help keep your backup sets
organized.

You set this session information after you have created a catalog of files to
backup, but before you actually begin the backup.

To set the session information:
· Generate a catalog for the backup session you wish annotate.

· Before actually beginning the backup, choose Set Session Info from the
Utilities menu. A requester will appear.

· Type the backup name and comments you wish to add, and click on the
"OK" button.

You can view the session information for any backup set.

To get the session information:
· Load the catalog from a backup set by choosing to restore from that

session.

· Choose Get Session Info from the Utilities menu. A requester will
appear.

· After you have noted the information of interest, click on the "OK"
button.

Automatic Tag Filters

When Quarterback generates a catalog of files to backup, or loads a catalog
from a backup set for restoring, it normally will automatically tag all files
in the catalog for backing up or restoring. You can override this and have
Quarterback automatically tag only the files you want by supplying an
"automatic tag filter".

An automatic tag filter is simply a list of AmigaDOS patterns that you wish to
use as your tag filter (see the Selecting the Files to Backup section for more
information about tag filters and pattern matching). Only files in the catalog
that match one of the patterns in the tag filter’s pattern list will be
automatically tagged. Quarterback uses two different automatic tag filters -
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one for tagging files to backup, and one for tagging files to restore. You can
use Quarterback’s Tag Filter command to create these tag filter files, or any
text editor.

To create an automatic tag filter:
· Choose Tag Filter from the Tag menu (you must have a backup or restore

catalog displayed to have this command available). A requester will
appear.

· Add the AmigaDOS file name patterns to the pattern list by typing the
patterns in the text box and clicking on the "Add" button.

· To create an automatic tag filter for backups, save the tag filter list
with the name "QB Backup Filter" in the same location (disk and drawer)
as the Quarterback program.

· To create an automatic tag filter for restores, save the tag filter
list with the name "QB Restore Filter" in the same location (disk and
drawer) as the Quarterback program.

Compression

Quarterback can optionally compress your files as it backs them up. This can
save up to 50% on the amount of storage space needed for the backup. However,
unless you are using an accelerated Amiga, this can slow down backups.

To turn on compression:
· Choose Backup Options from the Options menu, or click on the "Proceed"

button after tagging files for backup. A requester will appear.

· Turn on the "Compress output" check box.

· Select the type of compression you desire, from 12 bit to 16 bit
compression. Higher compression types are more efficient, but require
more memory. If you encounter "out of memory" errors while backing up,
choose a lower compression type.

Depending upon the file size and contents, you can get up to 50% compression
efficiencies. Generally, larger files can be compressed more than smaller ones,
and text files can be compressed more than binary files (such as programs).

Password Protection

To keep sensitive data safe from others, you can protect your backup sessions
with a password. When you use Quarterback’s password protection feature, the
data is encrypted when it is backed up so that others cannot extract your data
even if they obtain a copy of your backup set.

To password protect your backup session:
· Choose Backup Options from the Options menu, or click on the "Proceed"

button after tagging files for backup. A requester will appear.

· Turn on the "Password protection" check box.

When you actually begin your backup by clicking on the "Start" button,
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Quarterback will ask you to supply a password for the backup session. Remember
your password!

When you attempt to load a catalog from a backup set that has been password
protected, Quarterback will ask you for the password. If after three tries you
have not entered the correct password, Quarterback will deny access to the
backup set.

Be careful when you use Quarterback’s password protection option, as it is
impossible to recover your data if you forget your password!

I/O Buffer Control

Quarterback gives you control over the size and type of memory used for its
input/output (I/O) buffers used for tape and removable disk backups (not
floppy backups), and also over the type of I/O performed to and from these
buffers. You should leave these settings at Quarterback’s defaults unless you
are having problems with your tape drive or removable drive.

To set I/O buffer options:
· Choose Buffer Options from the Options menu. A requester will appear.

· If your tape backups or restores seem too slow - i.e. if it sounds like
your tape drive is stopping and backing up a lot - try increasing the
backup or restore buffer size by typing a new number in the text box
or using the up and down buttons. You can increase the buffer size to
as much as 8 megabytes (note that since Quarterback does
"double-buffering" when it writes to the tape drive, the actual amount
of memory used for the backup buffer is double, and sometimes triple,
the amount shown).

· If you are getting "Out of memory" errors during backups or restores,
try decreasing the backup or restore buffer size. You can decrease the
buffer size to as little as 1 kilobyte. Note that decreasing the buffer
size may slow down backup and restore operations.

· If you are having problems getting reliable backups, turn off the
"Asynchronous I/O" check box. Some SCSI interface adapters do not
properly support asynchronous I/O, and will generate read/write errors
when Quarterback attempts this. Turning this option off will slow down
backups.

· If your SCSI controller or driver requires its buffers to be in memory
that is accessible to the Amiga’s graphics chips (sometimes called
"Chip" memory), select the "Graphics" button for buffer memory type.

· The "24-bit" option will allocate buffer memory only from within the
CPU’s 24-bit address space. Choosing "Any" will allocate a buffer
from anywhere in the full 32-bit address space.

· Click on the "OK" button when you have finished setting the buffer
options.

Not all SCSI controllers support DMA (direct memory access) to memory outside of
a 24-bit address space. If you have your buffer memory type set to "Any" and are
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experiencing problems with Quarterback, try changing it to "24-bit".

If you select "24-bit" but do not have any expansion memory in the 24-bit
address space, Quarterback will allocate its buffers from graphics memory.
Depending upon your computer’s configuration, this may slow down Quarterback’s
operations.

Tape Control

Quarterback gives you direct control over tape drives, allowing you to erase
tapes, tension them, and rewind them. You can also have several different
backup sessions on the same tape (if the tape is large enough), and have
Quarterback skip to the one you want. Backups over multiple tapes are also
supported.

To control tape drives:
· If you are at Quarterback’s initial start-up display, or are viewing a

catalog from a disk in preparation to perform a backup, select the tape
device you wish to control with the "Backup Options" requester. If you
are viewing a catalog from a backup set in preparation to perform a
restore, select the tape device you wish to control from the "Restore
Options" requester.

· Choose Tape Control from the Utilities menu. A requester will appear.

· To rewind a tape, click on the "Rewind" button.

· To tension a tape, click on the "Tension" button.

· To erase a tape, click on the "Erase" button.

· Some advanced tape drives support a quick erase mode. To use this
mode when erasing tapes, turn on the "Quick Erase" check box before
clicking on the "Erase" button.

· To skip over a backup session on a tape (and advance to the next one,
or to a blank portion of the tape), click on the "Advance" button. Note
that you will have to keep track of the number of backup sessions on a
tape, as Quarterback has no way of determining this. You can specify
the number of sessions to advance over on a tape. To advance past
several backup sessions on a tape, use the up and down arrows next to
the "Advance" button (or use the up and down cursor keys) to specify
the number of sessions to advance past, and click on the "Advance"
button.

· On tape drives which support it, Quarterback will automatically use a
fast advance mode (also called a "fast search" mode). On these tape
drives, this can significantly reduce the time spent advancing a tape.

To set the tape drive options:
· Select Tape Options from the Options menu.

· To have Quarterback automatically re-tension a tape whenever you insert
it into your tape drive, turn on the "Auto-retension inserted tapes"
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check box.

· To have Quarterback automatically rewind tapes after every backup or
restore, turn on the "Rewind after backup or restore" check box.

With these controls, you can easily put multiple backup sessions on a single
tape. Simply turn off the "Rewind after backup or restore" option, and use the
same tape as the destination for several backups. To restore from these backups,
first rewind the tape and then skip to the backup session you wish to restore
from.

Note: When putting multiple backup sessions on a single tape, never attempt to
write over a session in the middle of a tape. Either start at the beginning of
a tape (preferably erasing the tape first), or add a new session after the
final session on the tape.

Multiple Tape Support

You can automatically back up a disk that is larger than the size of your
tapes. Quarterback will detect when the current tape is full, and prompt you
for another tape. When restoring files, Quarterback will prompt you for the
tapes in the correct order.

Note: Different tape drives report a tape-full condition differently. While we
have tested Quarterback with several different types of tape drives, including
all of the most popular drive types, there may be some less common drives that
have problems with this feature. If you encounter a problem with this feature
please contact our technical support department. Please have information about
the type of tape drive you are using and the size of the tapes you are using
available.

Tape Drive Compression

Some advanced tape drives support built-in compression. Since this compression
is handled by the tape drive hardware, it is much faster than the compression
built into Quarterback.

If your tape drive supports compression you can use this feature by choosing
Backup Options from the Options menu, clicking on the "More" button, and then
selecting "Use device compression" as the compression type.

Preferences

There are a few other settings you can make to customize Quarterback to your
own preferred way of operation.

To set misc. preferences:
· Choose Preferences from the Options menu. A requester will appear.

· Indicate how you would like to have Quarterback notify you of errors,
either by flashing the screen, making a beep sound, or both, by turning
on or off the "Flash screen" and "Beep sound" check boxes under
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"Error notification".

· You can have Quarterback notify you when you need to change floppy
disks, either by flashing the screen, beeping, or both, by turning
on or off the "Flash screen" and "Beep sound" check boxes under
"On disk completion".

· To have Quarterback create icons when it saves files, turn on the
"Save icons with Quarterback files" check box.

· To have Quarterback warn you when it encounters an invalid file name in
the catalog, turn on the "Warn on invalid file names" check box.
Invalid file names are names that are either too long, or contain an
asterisk "*", a colon ":", or slash "/" character. They can occur if a
disk has a directory problem, or when backing up over a network that
doesn’t properly filter out invalid file names.

· To have Quarterback list assigned directories in the initial list of
volumes, turn on the "Include assigned directories in list of volumes"
check box.

· Click on the "OK" button when you have finished setting your preferences.

Workbench 2.0 Features

Quarterback provides several additional features when you are using Workbench
2.0. The main improvements are the "Application Icon" or "AppIcon" and
"Application Menu Item" or "AppMenuItem" features.

When Quarterback is started on a Workbench 2.0 system, it will put an AppIcon
named "QB Desposit" on the Workbench screen. If you double-click on this icon,
Quarterback will bring its screen and window to the front. If you drag a
Quarterback Settings file onto this icon, that settings file will be loaded.
If you drag a backup file (a backup session that was saved as a file) onto this
icon, Quarterback will read the catalog from the backup file and prepare for
restoring from that file (make sure before you drag the backup file onto the
icon that you first select the correct restore destination in Quarterback’s
window). Finally, if you drag a disk or drawer icon onto Quarterback’s deposit
icon, Quarterback will create a catalog of the files in that disk or drawer
and prepare for backing it up.

Quarterback also adds an AppMenuItem named Quarterback to Workbench’s Tools
menu. When you choose this menu item, Quarterback will bring its screen and
window to the front. If you are running Workbench 2.04 or later, if you select
an icon before choosing this menu command, Quarterback will load or setup for
backing up or restoring just as if you had dragged that icon over the
"QB Deposit" icon.

1.13 Program Settings

Program Settings

With Quarterback, you can save all of the settings you have made in all of the
requesters from the Options menu, as well as the "Page Setup", "Print",
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"Tag Filter", and "Tape Control" requester settings. You can either save these
settings as your defaults, so they will be automatically set whenever you
start Quarterback, or as separate "Settings" files that you can load at a any
time.

To save program settings:
· Set all of Quarterback’s settings and preferences the way you want them.

· Choose Settings >> Save As from the Project menu. A requester will appear.

· Specify a name and location to save these settings, and click on the
"Save" button.

You can load Quarterback’s settings at any time.

To load program settings:
· Choose Settings >> Load from the Project menu. A requester will appear.

· Select the settings file you wish to load and click on the "Open" button.

When Quarterback starts up, it looks for a settings file with the name
"QB Settings" in the same location as the Quarterback program. If this file is
found, Quarterback automatically loads these settings. You can have Quarterback
automatically create this file for you.

To create a default settings file:
· Choose Settings >> Save from the Project menu, and click on the "Yes"

button to create the default settings file.

1.14 Macros and AREXX

Macros and AREXX

Quarterback includes a facility which allows you to create "macro" programs
using the AREXX programming language. Macros allow you to automate repetitive
operations with Quarterback, giving you the ability to simplify working with
Quarterback and customize your work environment. You must have AREXX installed
on your system in order to use Quarterback’s macros (AREXX is included as part
of AmigaDOS 2.0).

Creating and Using Macros

A macro program consists of a series of normal Quarterback commands. Once
created, a macro can be executed as though it was a single command - either by
choosing an item from the Macro menu or by holding down the shift key and
pressing a function key.

Macros are normally considered to be a feature for "advanced" users. To use
them, you must have the AREXX language system installed on your Amiga, and you
should have some familiarity with the language. For additional information
about AREXX, refer to the AREXX manual that came with your AREXX system.

To create a macro:
· Use a text editor (such as the CLI’s "Ed") to write the macro program.
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A complete listing of Quarterback’s macro language commands appears
in the Quarterback Reference chapter. Here is an example of a simple
macro program:

/* Backup Work partition */
Backup "Work:"
TagAll
Proceed

Note that the first line of an AREXX program must be a "C style"
comment (it must start with "/*" and end with "*/").

· Save the macro program as a "Text Only" (or "ASCII") file in the same
location (disk and drawer) where Quarterback is located. You may give
the macro any name you like.

You can invoke Quarterback macros either with they keyboard or the menu. And
because Quarterback’s macros run through AREXX, you can also start up a
Quarterback macro from a program other than Quarterback.

Quarterback opens an AREXX "port" named "Quarterback". However, you do not need
to reference this port name unless you are invoking AREXX macros from outside
of Quarterback. If you are running two or more copies of Quarterback
simultaneously, the second instance of Quarterback will open a port named
"Quarterback.1", the third a port named "Quarterback.2", and so on.

To use a macro:
· Before using macros, you must start up the AREXX resident process with

the language’s "RexxMast" CLI command. This command should be included
in your system’s startup sequence. See your AREXX documentation for
details.

· If you have customized Quarterback’s Macro menu to include your macro
name (see later in this section for information about customizing the
Macro menu), simply choose the corresponding command from Quarterback’s
Macro menu, or hold down the shift key and press the corresponding
function key. The commands in the macro file will be executed.

· For any other macro programs stored in Quarterback’s directory, or if
you need to give a parameter to your macro, choose Other from
Quarterback’s Macro menu. A requester will appear where you can type
the desired macro’s name and specify an optional parameter.

· AREXX programs which are run externally, either using AREXX’s "rx" CLI
command or another AREXX-compatible program, may also send commands to
Quarterback. AREXX programs that are started in this way must have an
"Address ’Quarterback’" command line before any Quarterback macro
commands in order to for Quarterback to receive the AREXX commands.

Macro Parameters

You can pass parameters to your macros when you invoke them from Quarterback.
You can use macro parameters as a way of sending your macro additional
information that it can use when executing your command.

To send a parameter to a macro:
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· Choose Other from the Macro menu. A requester will appear.

· Type the name of the macro you wish to execute, press return, and type
the parameter you wish to have sent to the macro.

· Click on the "Execute" button to execute the macro.

Your macro programs can retrieve the parameter passed to them by using the
ARG() AREXX command. For example:

numParams = ARG()

will return in the variable "numParams" the number of parameters passed to the
macro (zero or one), and

parameter = ARG(1)

will return the parameter sent to the macro.

Macro Menu Customization

You can customize the macro names in the Macro menu. When you change a macro
name in the menu, you also change the corresponding shift-function key command
equivalent.

To customize the Macro menu:
· Choose Customize from the Macro menu. A requester will appear.

· Change the macro names for each of the ten entries to the names of the
macros you wish to use.

· Click on the "Use" button to use the new macro names without making
them the default settings. Click on the "Save" button to use the new
settings and also save them as your default macro menu settings.

When you save your macro name settings, Quarterback creates a file named
"QB FKeys" in the same drawer as Quarterback. Quarterback will look for this
file when it starts up, and will set the macro menu to the settings it contains.

Remember that you must hold down the shift key when you press a function key in
order to invoke a macro from the Macro menu. Pressing a function key without
holding down the shift key will execute a menu command instead.

Other Macro Features

When Quarterback first starts up, it will automatically execute the AREXX macro
named "QB Startup" if one is present in the same directory as the
Quarterback program.

Note that there is no way for the AREXX port in Quarterback to respond to
requesters. If any command causes Quarterback to display a requester, the user
must acknowledge the requester before the macro can continue.

Quarterback will report errors and failures of macro commands. If a command has
improper parameters, Quarterback will set the AREXX variable RC to 5. If a
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macro command fails, Quarterback will set RC to 10. Finally, if a command is
sent to Quarterback that it does not understand, Quarterback will set RC to 20.

If Quarterback is started from the CLI, it will display diagnostic messages in
the CLI window whenever it detects errors in a macro program. These messages
will not appear if Quarterback was started from the Workbench.

1.15 Quarterback Reference

Quarterback Reference

This chapter provides an overview and summary of Quarterback. Designed for you
to use as a quick-reference section, it describes the commands and functions
of the program without going into procedural detail. The material presented
here has been covered in greater depth in Using Quarterback. Refer to the
appropriate sections of that chapter for step-by-step instructions.

The sections in this chapter are:

· The Window

· The Menus

· Macros and AREXX

· Shortcuts

1.16 Reference: The Window

The Window

Quarterback’s window is divided into two regions: The control panel on the
left and the list display on the right. The information displayed of these
regions can change, depending upon what you are doing with Quarterback.

Initially, Quarterback starts up with a list of disks (and optionally
"assigned" directories) in the list display, and the buttons "Backup",
"Restore", "Enter", and "Back" in the control panel. The "Enter" and "Back"
buttons allow you to enter into and back out of a disk or drawer. To enter a
disk and see its contents, select the disk by clicking on it and click on the
"Enter" button (or just double-click on the disk). You can enter drawers in a
similar fashion. To back out of a drawer, click on the "Back" button. When
you hold down the alt key, the "Back" button changes to "Root", and will take
you back all the way to the initial list of disks.

To begin a backup or restore operation, select the disk or drawer you wish to
backup or restore to and click on either the "Backup" or "Restore" button. For
a backup operation, a catalog of the selected disk or drawer will be built and
displayed in the list. For a restore operation, you will be presented with the
"ÒRestore Options" requester where you must specify where you are restoring
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from. Once you have chosen a source, the catalog from that backup set will be
read and displayed in the list.

In the list, each file will be shown with a miniature file icon, while drawers
will have a miniature drawer icon. Quarterback also supports hard and soft
links created by the AmigaDOS 2.0 filing system; links will be shown with gray
icons and italic text.

From the list, you must tag all of the files you wish to backup or restore. A
tagged file has a check mark displayed next to its name. A drawer which has all
of its contents tagged will also have a check mark next to its name; if a
drawer has only some of its contents tagged, it will have a dash next to its
name. To tag or untag files, select the files with the mouse and use the "Tag"
and "Untag" buttons in the window, or the commands in the Tag menu. When you
hold down the alt key, the "Tag" and "Untag" buttons change to "Tag All" and
"Untag All"; use these buttons to tag or untag everything from the current
directory level down all at once.

If there is a tag filter file called "QB Backup Filter", or "QB Restore Filter"
in the same disk and drawer as Quarterback, then Quarterback will automatically
apply the appropriate tag filter to the initial catalog. Otherwise, it will
automatically tag all files in the catalog.

After you have tagged the files you wish to backup or restore, click on the
"Proceed" button. If you are performing a backup, the "Backup Options"
requester will be displayed where you must specify the destination of the
backup. You can backup to floppies, tape drives, or to a file. Once you have
begun the backup or restore operation, Quarterback will display session
information in the list display, as well as prompt you for floppy disks if you
are backing up to or restoring from floppies.

Once the backup or restore is complete, you can choose to save or print the
session log. Click on the "Done" button when you are finished; you will be
returned to Quarterback’s initial display.

Workbench 2.0 Features

If you are using Workbench 2.0 then when it is run, Quarterback will add an
icon called "QB Deposit" to your Workbench screen, and a menu called
"Quarterback" to the Workbench’s Tools menu. These items can perform several
functions:

· Double-clicking on the icon, or choosing the menu item will cause
Quarterback’s screen and window to be brought to the front.

· Dragging Quarterback files onto the deposit icon, or selecting
Quarterback files and choosing the menu item, will load those files.
The types of files you can load this way are Quarterback Settings
files, and Backup files (files created by backing up to an AmigaDOS
file). Loading a backup file will cause Quarterback to set itself up to
restore from that file.

· Dragging a disk or drawer icon onto the deposit icon, or selecting a
disk or drawer icon and choosing the menu item, will build a catalog of
the disk or drawer and prepare for backing it up, just as if you had
selected the disk or drawer from Quarterback’s initial list and clicked
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on the "Backup" button.

Hardware Issues

Since SCSI device units can only be in the range of zero through seven, it may
seem odd that Quarterback lets you specify device numbers higher than that when
selecting a tape drive for backup or restore. The reason for this is because
some device drivers use the higher numbers for other purposes, such as accessing
drives attached to a second expansion card, or to access non-SCSI devices. For
example, the A2090 card from Commodore uses unit numbers of two through nine for
SCSI devices zero through seven; units one and two are used for the ST-506 ports
on the card.

Quarterback has been designed to work with as many different SCSI expansion cards,
hard disks, and tape drives as possible. However, Quarterback can only be as good
as the device driver software for the cards installed in your system. If you
discover a problem with your particular configuration, please contact the
manufacturer of the your expansion card first; often times they have a new
updated device driver that will correct the problem.

In particular, because of problems in Commodore’s device driver software for the
A2090 and A2090a cards, Quarterback may not support all tape backup units when
connected to the SCSI port on these cards. We recommend you replace your card
with a newer one, such as the A2091.

1.17 Reference: The Menus

The Menus

Quarterback has five menus: Project, Options, Tag, Utilities, and Macro.

The Project menu has commands for saving and printing the file catalog, as well
as saving and loading Quarterback’s current settings.

The Options menu has commands for setting all of Quarterback’s backup and
restore options, as well as various user preferences.

The Tag menu has commands for tagging or untagging files based upon a variety
of criteria.

The Utilities menu has miscellaneous commands for such things as controlling
tape drives, and obtaining information about the SCSI devices attached to your
system.

The Macro menu has commands for executing AREXX macro commands.

The Project Menu

The Project menu provides commands for saving and printing the file catalog, as
well as commands for loading and saving QuarterbackÕs current settings.

About Quarterback Keyboard equivalent: help
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Displays copyright information about Quarterback.

Save Catalog As Keyboard Equivalent: F3
Save Session Log As

Save the file catalog or backup/restore session log, whichever is currently
displayed in the window. The menu command name will change to reflect which will
be saved.

A requester is displayed where you can specify the name and location you would
like to save the catalog or session log. When saving the catalog, you can save
it in "Normal" format which saves complete information about each file, or in
"Hierarchical" format which saves just the file names, but in a tab-indented
format suitable for viewing in programs like Flow from New Horizons Software,
Inc.

Page Setup Keyboard Equivalent: F4

Set the page format for printing the file catalog and/or the session log.

A requester is displayed where you can specify the paper size, print pitch,
line spacing, unit of measurement (for the paper size), and whether you wish to
print across the paper perforation.

Print Catalog Keyboard Equivalent: F5
Print Session Log

Print the file catalog or backup/restore session log, whichever is currently
displayed in the window. The menu command name will change to reflect which
will be printed.

A requester is displayed where you can specify the print quality, number of
copies, paper handling, printer font number, and whether to print to the
printer or to a file. If you print to a file, a requester will be displayed
where you can specify the name and location to send the printer output.

Settings

Displays a submenu of commands for saving or loading Quarterback’s current
settings. The settings that are saved include all backup and restore options,
catalog options, log file options, buffer options, and user preferences.

Save

Saves Quarterback’s current settings as the default values. These values will
then become the new defaults every time you start Quarterback.

Save As

Prompts you for a name and location to save Quarterback’s current settings.
You can then load these settings at any later time.
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Load

Prompts you for a settings file to load. The settings contained in the
specified file will become the current settings.

Quit Keyboard equivalent: Amiga-Q

Ends your session with Quarterback. Equivalent to clicking in the Quarterback
window’s close box.

The Options Menu

The Options menu provides commands for setting Quarterback’s backup and restore
options, as well as commands for setting your preferred setup.

Backup Options Keyboard Equivalents: F6 or Amiga-B

Allows you to specify the destination of your backup session, as well as set
several backup options.

A requester is displayed where you can specify these settings. You can
either choose a complete backup or a selective backup. You can choose
to have the backup done on floppy drives (up to four), tape drives, removable
drives such as SyQuest drives, or to an AmigaDOS file. To backup to tape drives
or removable drives, you must select the appropriate device driver and unit
number for your device. For the Amiga 3000 computer, choose the "scsi.device"
device driver; for other SCSI adapters, refer to the manual that was provided
with your SCSI adapter for information about the name of the device driver to
select. The name of the device you have selected will be displayed in the top
of the requester.

You can have Quarterback always display the "Backup Options"
requester before it begins a backup. If you always perform the same type of
backup, and you never change your "Backup Options" settings (and you have
saved these settings as Quarterback’s defaults with the Settings >> Save
command), then you may wish to turn this option off.

You can also specify several backup options though clickng the "More"
button. You can choose to compress the
output to save space on the destination media; several levels of compression
are available (from 12 bit to 16 bit), the larger compression settings give
better results but take more memory, and enabling compression at any level may
slow down the backup process. You can enable tape drive built-in hardware
compression. You can have your backup session protected by a
password you supply; if so then the data will be encrypted and you will need to
provide your password before you can retrieve the data. You can choose to have
each file’s archive flag set when it is backed up; while this is a bit slower
it does make it easy to later determine which files you have already backed up.
You can have the backup verified after it is written; this ensures the backup
set is readable, but it does double the amount of time it takes to perform a
backup. You can have Quarterback warn you if you try to backup to a disk that
is already formatted as an AmigaDOS disk; this will prevent you from
accidentally erasing the wrong disk. You can make a backup of the entire
directory structure of the disk even if you are backing up only a few files
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from the disk.

Restore Options Keyboard Equivalents: F7 or Amiga-R

Allows you to specify the source of your restore session, as well as set
several restore options.

A requester is displayed where you can specify these settings. You can
choose to either do a restore, a compare of the backup to the selected
destination, or a test of hte backups integrity. Comparing the backup data to the
original source, instead of restoring is useful for determining that the backup
set is still readable and correct. You can choose
to restore from floppy drives (up to four), tape drives, removable drives
such as SyQuest drives, or from an AmigaDOS file. See the Backup Options
command for more information about these settings.

You can have Quarterback always display the "Restore Options"
requester before it begins a restore. If you always perform the same type of
restore, and you never change your "Restore Options" settings (and you have
saved these settings as Quarterback’s defaults with the Settings >> Save
command), then you may wish to turn this option off.

You can also specify several restore options through clicking the "More"
button. You can specify whether to prompt you or automatically replace existing
files that are older than the one in the backup set or to replace existing files
that are newer than the one in the backup set. You
can have the file dates on the restored files be set to their original date,
the date the backup was made, or the current system date. You can choose
whether or not to restore empty drawers; turn this option on if you want the
disk restored exactly as it was when it was backed up. You can choose to
restore each file’s archive flag, indicating that the file was backed up. You
can have Quarterback restore the full directory structure of the backup set,
or simply restore all files to the same directory.

Catalog Options Keyboard Equivalent: F8

Allows you to specify the format you would like to use when displaying the
file catalog.

A requester is displayed where you can specify whether to have the catalog
display the file size, protection flags, and/or the date and time the file
was last modified. You can have the catalog sorted by file name, size, or
date, and either have the drawers sorted in with the files or grouped together
at the top of the catalog. You can specify to have 12 hour (AM/PM) or 24 hour
time, and whether or not to include the seconds with the time display.
Finally, you can choose from several different date formats.

Session Log Options Keyboard Equivalent: F9

Allows you to specify what information you wish to have included in the session
log. The session log is generated when a backup is performed, and is displayed
in the window during the backup and optionally can be saved at the end of the
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backup session.

A requester is displayed where you can specify to have errors only, errors and
drawer names, or errors, drawer names, and file names included in the session
log. You can have the end of the session log include information about the
average backup rate in megabytes per minute for the session, as well as the
compression efficiency (if compression was turned on in the "Backup Options"
requester). You can also have the session log not be displayed while backups
or restores are in progress. Finally, you can specify whether or not to
automatically save the session log when the backup operation is complete, and
what name to use if it is automatically saved.

Buffer Options Keyboard Equivalent: F10

Allows you to specify the memory buffer sizes and attributes used for backup
and restore operations, and the type of I/O operations to perform.

A requester is displayed where you can specify the buffer sizes for both backup
and restore, anywhere from 1 kilobyte to 8 megabytes (if you have enough memory
installed in your computer), and whether to use any available memory,
24-bit memory or only
the memory that is accessible to the Amiga’s graphics chips. You can also
specify whether or not to do asynchronous I/O; in general asynchronous I/O is
faster, but some SCSI adapters may not fully support it.

Tape Options

Allows you to specify whether or not to auto-tension inserted tapes and
also whether or not to rewind a tape after a backup or restore.

Preferences Keyboard Equivalent: shift-help

Allows you to specify miscellaneous program settings.

A requester is displayed where you can specify how to be notified of errors
and disk completion,
whether to save icons with files, whether to warn you when invalid file names
are found while creating a catalog (this can happen with some Amiga network
adapters), and whether or not to list "assigned" directories in the initial
list of disks.

Reset All

Resets all of Quarterback’s options and preferences to their built-in default
values.

The Tag Menu

The Tag menu lets you specify which files you want tagged for backup or
restore operations. Only files that are tagged will be backed up or restored.
Tagged files and drawers have a check mark displayed next to their icon in the
file list. If a drawer has some, but not all, of its contents tagged, then a
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dash will be shown instead of a check mark.

To tag or untag files, first select the files by clicking on them. To select
multiple files, either drag across them, or hold down the shift key while
clicking on them. Once you have selected the files to be tagged or untagged,
use the commands on this menu, or the Tag and Untag buttons in the window.

Tag Selection

Tag the currently selected files or drawers for backup or restore. Tagging a
drawer will tag the entire contents of the drawer.

You can also tag selected files and drawers by clicking on the "Tag" button.
If a file us untagged, you can also tag it by double-clicking on its name
(double-clicking on a drawer will enter that drawer and display its contents).

Tag All Keyboard Equivalent: Amiga-T

Tag all files at the current directory level and all levels below it.

You can also perform this command by holding down the alt key and clicking on
the "Tag" button (its name will change to "Tag All" when you press the alt
key).

Untag Selection

Untag the currently selected files or drawers. Untagging a drawer will untag
the entire contents of the drawer.

You can also untag selected files and drawers by clicking on the "Untag"
button . If a file is tagged, you can also untag it by double-clicking on its
name (double-clicking on a drawer will enter that drawer and display its
contents).

Untag All Keyboard Equivalent: Amiga-U

Untag all files at the current directory level and all levels below it.

You can also perform this command by holding down the alt key and clicking on
the "Untag" button (its name will change to "Untag All" when you press the
alt key).

Tag Filter Keyboard Equivalent: Amiga-F

Allows you to tag or untag files based upon a number of criteria.

A requester is displayed where you can specify these criteria. You can tag or
untag files based upon whether they have their "archive" flag set, based upon
the date they were last modified, or whether their name matches one of a list
of file name "patterns" you specify.

To specify a file name pattern, type the pattern in the text box (using
standard AmigaDOS wild-card characters) and click on the "Add" button. To
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remove a pattern from the list, click on the pattern and then on the "Remove"
button. To load or save pattern lists, click on the "Load" or "Save" buttons;
a requester will be displayed where you can specify the name and location of
the pattern file to load or save. Pattern files are simple text files, so you
can also edit them with any text editor.

If you wish to tag or untag only those files at the currently displayed
directory level, turn on the "Apply only to files in current drawer" check box.
Otherwise, all matching files at the current and all lower levels will be
tagged or untagged.

The Utilities Menu

The Utilities menu provides miscellaneous utilities for working with Quarterback.

Tape Control Keyboard Equivalent: F1

Allows you to perform miscellaneous operations on tape drives that are
attached to your system.

A requester is displayed where you can set various tape handling options, as
well as send commands to the tape drive. The tape commands will be directed to
the tape device selected in the "Backup Options" requester, unless you have
begun a restore operation in which case the tape device selected in the
"Restore Options" will be used.

You can rewind the tape, tension the tape, erase a tape, do a quick erase on
the tape if your hardware supports
it, or advance the tape to the next backup session, and to
specify how many sessions to advance forward to.

Get Session Info Keyboard Equivalent: Amiga-G

Displays the session information for the files you are about to restore. This
command is not available until you have loaded the catalog from a previous
backup session in preparation for restoring.

The information shown is the date the backup set was created, the name of the
backup set, and any comments that you may have specified with the Set Session
Info command.

Set Session Info Keyboard Equivalent: Amiga-I

Allows you to specify session information for a backup session you are
performing. This command is not available until you have created a file
catalog in preparation to performing a backup.

You can specify a name for the backup session, as well as a comment.

SCSI Interrogator Keyboard Equivalent: F2

Displays information about SCSI devices you have attached to your system.
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A requester is displayed where you can specify the device driver and unit
number for the SCSI device you wish to interrogate. For the Amiga 3000
computer, choose the "scsi.device" device driver; for other SCSI adapters,
refer to the manual that was provided with your SCSI adapter for information
about the name of the device driver to select.

The Macro Menu

Macro_1, Macro_2, Macro_3, ... Macro_10

Executes the corresponding AREXX macro program.

The macro program must be saved as a "Text Only" (ASCII) file in the same
directory (disk and drawer) as Quarterback, and be named "Macro_1", "Macro_2",
and so forth.

Each of these commands may also be executed by holding down the shift key and
pressing the corresponding function key at the top of the Amiga keyboard.

You can customize the names of these menu commands (and the names of the macro
program files they execute) by using the Customize command on the Macro menu.

Other Keyboard equivalent: Amiga-M

Allows you to execute a macro command that is not listed in the menu.

A requester is displayed where you can type the name of any AREXX macro program
which is stored in the same directory (disk and drawer) as Quarterback.
Clicking the "?" button next to the macro name text box will display
Quarterback’s "Open File" requester which you can use to find the macro you wish
to execute. When you find the nacro and click on the "Open" button, the full
macro path name will be automatically entered into the macro name text box. You
can also enter an optional parameter that is passed to the macro program. Macro
parameters can be retrieved by AREXX macro programs and used for internal
purposes.

Customize

Allows you to customize the commands listed in the Macro menu.

A requester is displayed where you can change the names of the Macro menu
commands. You can either use these new settings for this session only, or save
them as your default setup.

1.18 Referenece: Macros and AREXX

Macros and AREXX

If you have the AREXX system installed on your Amiga, Quarterback will
automatically create a software "port" where it can receive messages. This port
allows you to execute "macro" programs - essentially a collection of
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Quarterback commands executed in sequence - using the AREXX system. This
facility also allows other AREXX-aware programs to communicate and interact
with Quarterback.

The AREXX system is included as part of AmigaDOS 2.0 and later. If you are
using AmigaDOS 1.3 or earlier and wish to use Quarterback’s macro facility, you
will need to purchase AREXX from your software retailer and install it on your
system.

This section describes the AREXX commands supported by Quarterback. It assumes
that you are already familiar with the AREXX programming language. Please
consult the appropriate AREXX manual if you need more information about the
AREXX system.

Creating and Using Macros

A macro program must be a "Text Only" (ASCII) file containing a sequence of
AREXX commands - either Quarterback’s AREXX commands or the commands built into
the AREXX system. The first line in the file must be a comment. To be
accessible from Quarterback, the file must be stored in the same directory
(disk and drawer) as Quarterback. Up to ten macro programs can be invoked
directly with the menus or from the keyboard; others macros can be accessed by
typing their name in the Other Macro requester.

Before using macros, you must start the AREXX "resident process" with the
"RexxMast" command. Macro programs are invoked by choosing the appropriate
command on Quarterback’s Macro menu, or by holding down the shift key and
pressing the appropriate function key. If Quarterback is started from the CLI,
it will print diagnostic messages to the CLI window if any errors are detected
in a macro program.

Macro Language Commands

Quarterback provides the following commands for use by macro programs. Most of
these commands behave identically to an equivalent menu command. Note that
there is no way for the AREXX port in Quarterback to respond to requesters; if
a macro command causes Quarterback to display a requester the user must
acknowledge the requester before the macro can continue. In the following
descriptions, an item in parentheses () indicates an optional text string, an
item in brackets [] indicates an optional keyword. If several keywords are in
brackets separated by a vertical bar [|] then only one keyword in the list is
allowed.

Setting Options:
SetBackupDestination [options]
SetRestoreSource [options]

Where options are one of:
Tape (device name) (unit number)
File (file name)
Floppy [floppy options]
Floppy options are one or more of:

DF0On DF0Off
DF1On DF1Off
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DF2On DF2Off
DF3On DF3Off

SetBackupOptions [options]
Where options are one or more of:
Complete Selective
DisplayOptionsOn DisplayOptionsOff
ArchiveFlagOn ArchiveFlagOff
PasswordOn PasswordOff
VerifyDataOn VerifyDataOff
WarnDOSOn WarnDOSOff
EntireStructOn EntireStructOff
CompressOn CompressOff
CompressDevice CompressLevel (level)
The level parameter to the CompressLevel option must be between 12
and 16

SetRestoreOptions [options]
Where options are one or more of the following:
Restore Compare Test
DisplayOptionsOn DisplayOptionsOff
ArchiveFlagOn ArchiveFlagOff
EmptyDrawersOn EmptyDrawersOff
KeepStructureOn KeepStructureOff
ReplaceOn ReplaceOff ReplacePrompt
ReplaceEarlierOn ReplaceEarlierOff ReplaceEarlierPrompt
ReplaceLaterOn ReplaceLaterOff ReplaceLaterPrompt
DateOriginal DateCurrent DateBackup

SetCatalogOptions [options]
Where options are one or more of the following:
SizeOn SizeOff
ProtOn ProtOff
DateOn DateOff
TimeOn TimeOff
SecsOn SecsOff
AMPMOn AMPMOff
DrawersFirstOn DrawersFirstOff
SortByName SortBySize SortByDate
DateFormat (number)

SetSessionLogOptions [options]
Where options are one or more of the following:
ErrorsOnly ErrorsDrawersOnly AllInfo
NoDisplayOn NoDisplayOff
RateOn RateOff
CompressEffOn CompressEffOff
NoLogfile AutoSaveLogfile
SaveLogfileAs (filename)

SetBufferOptions [options]
Where options are one or more of the following:
AnyMem Any24BitMem GraphicsMem
AsyncOn AsyncOff
BackupSize (size)
RestoreSize (size)
The size parameter to the BackupSize and RestoreSize options is the
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number of kilobytes for the respective buffer.

SetTapeOptions [options]
Where options are one or more of the following:
AutoRetensionOn AutoRetensionOff
AutoRewindOn AutoRewindOff

Project menu commands:
About Display the "About Quarterback" requester
SaveAs Display the "Save As" requester to save either the file catalog

or session log
PageSetup Display the "Page Setup" requester
Print Display the "Print" requester to print either the file catalog

or session log
Quit Quit Quarterback

Options menu commands:
BackupOptions Display the "Backup Options" requester
RestoreOptions Display the "Restore Options" requester
CatalogOptions Display the "Catalog Options" requester
SessionLogOptions Display the "Session Log Options" requester
BufferOptions Display the "Buffer Options" requester
Preferences Display the "Preferences" requester
ResetAll Reset all options and preferences to their built-in defaults

Tag menu commands:
Tag Tag the currently selected files and drawers
TagAll Tag all files at the current directory level and down
Untag Untag the currently selected files and drawers
UntagAll Untag all files at the current directly level and down
TagFilter Display the "Tag Filter" requester

Utilities menu commands:
TapeControl Display the "Tape Control" requester
GetSessionInfo Display the "Get Session Info" requester
SetSessionInfo Display the "Set Session Info" requester
SCSIInfo Display the "SCSI Interrogator" requester

Tape control commands:
TapeErase Erase tape
TapeRetension Retension tape
TapeRewind Rewind tape
TapeSpace # Skip (space) over "#" (where # is a number) backup sessions

on tape

Other commands:
Backup (name) Begin a backup session for the named disk/directory by building

the file catalog. If no name is specified, then begin a backup
session for the currently selected disk/directory.

Restore (name) Begin a restore operation for the named disk/directory. If no
name is specified, then begin a restore operation for the
currently selected disk/directory.

Proceed Proceed with the backup or restore. This command is used after
the catalog has been read and the desired files have been
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tagged.

ProgName Returns the name of the Quarterback program in the AREXX
variable "result".

ProgVersion Returns the Quarterback version number in the AREXX variable
"result".

ScreenToFront Bring the Quarterback screen to the front.

ScreenToBack Send the Quarterback screen to the back.

SetPrint (print option) (print option)
Set one or more print options. Valid print options are:

NLQ Draft
AutoFeed HandFeed

SetPath path Set the current directory path to specified path name.

Request1 info Display a requester with specified information text and a
single "OK" button. Sets AREXX variable RC to 0.

Request2 info Display a requester with specified information text and two
buttons labeled "OK" and "Cancel". Sets the AREXX variable RC
to 0 if "OK" is pressed, and to 1 if "Cancel" is pressed.

Request3 info Display a requester with specified information text and three
buttons labeled "Yes", "No", and "Cancel". Sets the AREXX
variable RC to 0 if "Yes" is pressed, to 1 if "Cancel" is
pressed, and to 2 if "No" is pressed.

RequestText info Display a requester with specified information text, a
text box for user entry, and two buttons labeled "OK" and
"Cancel". Sets the AREXX variable RC to 0 if "OK" is pressed,
and to 1 if "Cancel" is pressed. If "OK" is pressed, also sets
the AREXX variable "result" to the text box contents entered
by the user.

Supplied Macros

On the Quarterback disk are some sample macros. If you are new to AREXX, you
might wish to study these examples to see how you can use Quarterback’s macro
commands and AREXX to accomplish complex tasks. These macros are also useful
for automating Quarterback with the Schedule Pro program. A brief description
of the included macros is as follows:

Backup (disk name)
This macro performs a backup of disk name specified as its argument, and then
quits from Quarterback. If no disk name is supplied, then it will prompt you
for the name of the disk to backup. Not only does this macro give you an
example of how to use macro arguments, but it can be used with the Schedule
Pro program included with Quarterback to perform scheduled backups. For
example, if you set up Schedule Pro to run Quarterback and supply the command
line argument of:

Backup Work:
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Then when Quarterback is started it will automatically back up the drive named
"Work:" and then quit. See the section on Schedule Pro for more information on
scheduling Quarterback or other programs to automatically run.

Multiple Backups
This macro allows you to set up and automatically perform several backups in
one step. You can use this macro as a fairly sophisticated example of how to
control Quarterback through AREXX. For example, you could use the
"SetBackupOptions" command to automatically set the backup options and bypass
the "Backup Options" requester entirely. You could even modify the macro to
automatically start Quarterback, perform one or more backups, and quit.

1.19 Reference: Shortcuts

Shortcuts

Quarterback lets you use the keyboard instead of the mouse for many of its
commands and operations. There are three types of keyboard shortcuts: menu key
commands, function key commands, and window/requester key commands.

There are also a few miscellaneous shortcuts that Quarterback provides.

Menu Key Commands

Choose the following commands by holding down the right Amiga key and pressing
the character key.

Press: To choose:

Amiga-B Backup Options
Amiga-F Tag Filter
Amiga-G Get Session Info
Amiga-I Set Session Info
Amiga-M Other Macro
Amiga-R Restore Options
Amiga-T Tag All
Amiga-U Untag All

Function Key Commands

The function keys provide an alternative to menu key commands. Simply press the
appropriate function key to choose the command.

Press: To choose:

F1 Tape Control
F2 SCSI Interrogator
F3 Save Catalog/Save Session Log
F4 Page Setup
F5 Print Catalog/Print Session Log
F6 Backup Options
F7 Restore Options
F8 Catalog Options
F9 Session Log Options
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F10 Buffer Options

Window & Requester Key Commands

Quarterback has several built-in conveniences for using the keyboard to
activate window and requester items:

· You can select most push buttons, check boxes, and radio buttons in
Quarterback’s window and requesters by simply pressing the key
corresponding to the underlined character in the button name.

· In requesters which have text boxes, you can activate the first text
box in the requester by pressing the tab key, and if you are using
AmigaDOS 2.0 you can switch from one text box to another pressing tab
(to go to the next text box) and shift-tab (to go to the previous one).

· Some text boxes are linked by Quarterback (for example, the day, month,
and year text boxes where a date is requested); you can switch among
linked text boxes, regardless of the version of AmigaDOS you are using,
by pressing return and shift-return.

· Whenever there is an outlined push button in the window or requester,
you can select that button by pressing the enter key. You can also
select it by pressing the return key, unless you are in a linked text
box.

· In most requesters, the "Cancel" or "No" push button can be selected
by pressing the esc key.

There are a few more keyboard equivalents that Quarterback provides:

Key: Action:

help Display "About Quarterback" requester
shift-help Display "Preferences" requester
Cursor up Move selection up in catalog and file requesters
Cursor down Move selection down in catalog and file requesters
Cursor right Enter selected directory in catalog and file requesters
Cursor left Back out one directory level in catalog and file requesters
alt-cursor left Back out to volume list or root level in catalog and file

requesters

Miscellaneous Shortcuts

There are a few miscellaneous shortcuts available in Quarterback:

· Double-click on a disk or drawer name in the catalog or file requesters
to enter that drawer.

· Double-click on a file name in the catalog to tag or untag that file.

· Double-click on a file name in the file requesters to specify that file
to open or save.
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· When viewing a catalog, hold down the alt key and press the "Tag"
button to tag all files in the catalog from the current directory level
down (its name will change to "Tag All" when you press the alt key).

· When viewing a catalog, hold down the alt key and press the "Untag"
button to untag all files in the catalog from the current directory
down (its name will change to "Untag All" when you press the alt key).

1.20 Schedule Pro

Schedule Pro

Schedule Pro is a program which allows you to have Quarterback perform
automatic backups, either one-time or on a regular schedule. But Schedule Pro
goes far beyond that. Not only does it work with Quarterback, but you can use
it to automatically execute any AmigaDOS program, or even AREXX macro
programs, at the times you specify. You can even use it to display reminders
on your screen!

Important:
Schedule Pro requires AmigaDOS 2.0 or later. If you are using AmigaDOS 1.3 or
earlier on your computer you will need to upgrade your system. See your Amiga
dealer for information on upgrading.

Using Schedule Pro

Schedule Pro has two modes of operation: A window display mode where you can
create new and change events, and an icon-only mode where it is waiting to
execute scheduled events. When running in its icon-only mode, Schedule Pro uses
very little of your processor’s time.

To start Schedule Pro:
· Double-click on the Schedule Pro program icon. Schedule Pro will start

up, display its main window, add its "Application Icon", or "AppIcon",
to the Workbench screen, and add its name to the Workbench’s "Tools"
menu.

· To switch from the window display mode to the icon-only mode, click in
the window’s close box. The Schedule Pro window will be removed and
only its AppIcon will remain.

· To switch from the icon-only mode to the window display mode, either
double-click on the Schedule Pro AppIcon or choose it from the "Tools"
menu. Do not double-click on the program icon a second time, as this
will load and run a second copy of Schedule Pro.

· To have Schedule Pro always start up in the icon-only mode, add the
tooltype "NoWindow" (or simply "NW") to Schedule Pro.

· To quit Schedule Pro and remove it from memory, click on the "Quit"
button in the main window. No scheduled events will be executed until
the next time you start Schedule Pro.

Important:
To be most useful, Schedule Pro should be left running on your computer at all
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times. You can easily do this by putting it into your "WBStartup" drawer. That
way it will always be started whenever you start up your Amiga. If you do this,
you will need to add the tooltype "DoNotWait" to Schedule Pro; otherwise
Workbench will wait for Schedule Pro to quit before proceeding with its startup.
You should also add the "NoWindow" tooltype discussed above to keep Schedule Pro
from displaying its window when your computer is started.

Schedule Pro’s main window displays all of the events that you have created.
This window looks like this:

The buttons in this window let you create and schedule new events, change
existing events, and delete events.

To create and edit events:
· To create new events, click on the "New" button. The event

creator/editor requester will appear.

· To change an existing event, click on the event name and then click on
the "Change" button, or simply double-click on the event name.

· To delete an existing event, click on the event name and then click on
the "Delete" button. You will be asked if this is what you really wish
to do. Click on the "Yes" button to delete the event.

Creating and Changing Events

When you create new events or change existing events, Schedule Pro will display
the event editor, where you specify the event name, type, and schedule:

Before you specify when an event is to occur, you should first specify its name
and type. You use the items in the upper portion of the requester to do this.

To set an event name and type:
· To name the event you are creating, type a name in the "Schedule" text

box. This name will be displayed in Schedule Pro’s main list of events.

· To set the type of event, choose either "Program" or "Reminder" from
the event type pop-up menu. A "Program" event will run a specified
program, either an AmigaDOS program or an AREXX program. A "Reminder"
event will display a reminder on your screen at the specified time.

· If this is a program event, type the location and name of the program
in the "Program" text box. There must be a full path name to the
program in order for Schedule Pro to find it. You can click on the
"?" button and use the standard "Open" requester to locate the program.
If you do this, Schedule Pro will automatically enter the full path
name to the program you have located.

· For program events, you can also enter program arguments in the
"Arguments" text box. These items will be passed to the program when
it starts up, they are equivalent to the command line arguments you
would give a program when you start it from the CLI.

· If this is a reminder event, type the information you wish to appear
as your reminder in the "Reminder" text box.
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· If you wish to simply create a new event but not have it active yet,
select the "Inactive" option. Normally you will just leave the "Active"
option set.

Once you have set the event name and type, you need to specify the schedule for
when the event should occur. You use the items in the lower portion of the
requester to do this. Schedule Pro defaults to having the current date set for
the schedule, you can alter this if you need to have it occur at a different
time, or if you want to set it up as a repeating event.

To set an event schedule:
· Click on the month or months in which you want this event to occur.

Click once on the month name to select it, click on it again to
de-select it.

· If you want the event to occur every month, turn on the "Monthly" check
box.

· Click on the day or days in which you want this event to occur. Click
once on the day number to select it, click on it again to de-select it.

· To have the event occur on the same day every week, click on the day
name above the list of days. You can select more than one day of the
week for an event.

· If you want the event to occur on a particular week in the month, click
on the "1st", "2nd", "3rd", "4th", or "Last" buttons to select which
week in which you want this event to occur. You can select more than
one week of the month for an event.

· To have the day you select for the event be relative to the end of the
month, turn on the "From End of Month" check box. For example, if you
want to have event occur on the last day of every month regardless of
how many days are in that month, click on the last day displayed and
turn on this check box.

· If you want the event to occur every day, turn on the "Daily" check box.

· In the "Year" text box, either type the year in which you want this
event to occur, or use the up and down arrow buttons to specify a year.

· If you want the event to occur every year, turn on the "Yearly" check
box.

· In the "Time" text box, either type the time in which you want this
event to occur, or use the up and down arrow buttons to specify a time.

· If you want the event to occur every hour, turn on the "Hourly" check
box.

Once you have specified all the information for the event, you must save it in
order for it to be added to the list of scheduled events.

To save an event:
· Click on the "Save" button. The event will be saved and you will be

returned to Schedule Pro’s main window.
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Schedule Pro saves its events in a file called "Schedule Pro Events" located
in the "s:" directory. Normally this file is not visible to Workbench users.
CLI users should be careful not to delete this file, because if you do then
you will have deleted all of your events!

After a non-recurring event has been executed, it will remain in the event list
in an "inactive" state. Inactive events are displayed in italic type. At this
point you can either delete the event or reschedule it for a later time.

To activate or inactivate events:
· Click on the event in the event list and then click on the "Change"

button, or simply double-click on the event. The event editor will
appear with the selected event’s information.

· To activate an event, click on the "Active" option button. If this was
a one-time event that has already been executed, you will need to
specify a new date and/or time for the event.

· To inactivate an event, click on the "Inactive" option button. An
inactive event will not be executed, but its information will be kept
in the event list for your future use.

Examples

Here are two examples of how you can use Schedule Pro. One example shows how
you can use it to perform automatic backups of your hard disk, and the other
shows how to set up a simple birthday reminder.

Hard Disk Backup
If you have installed Quarterback and the sample AREXX macros that come with
it, then there is an AREXX macro program named "Backup" in Quarterback’s
"Macros" drawer. If you wanted to set up Schedule Pro to use this macro to back
up the "Work:" partition of your hard disk to a tape drive every Friday at
9:00 PM, follow these steps:

· Make sure Quarterback’s settings are set for backing up to your tape
drive, and save these as your default settings.

· Run Schedule Pro and click on the "New" button to create a new event.

· Type a name for this event - for example, "Backup Work Partition".

· Click on the "?" button and use the open requester to find Quarterback.
Click on "Open" once you have found Quarterback on your hard disk. The
full path name to Quarterback will be placed in the "Program" text box.

· Type "Backup Work:" in the "Arguments" text box. This will make
Quarterback execute the AREXX macro "Backup" and pass it the AREXX
parameter "Work:" when Quarterback is started.

· Click on the "F" button in the "Day" display to have it execute every
Friday.

· Click on the "Monthly" and "Yearly" check boxes to turn them on.
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· Enter the time of "21:00" (which is 9:00 PM, when written in 24-hour
time) in the time text boxes.

· Click on the "Save" button to save the event.

Your automatic backup is now scheduled and will occur on every Friday at
9:00 PM. Make sure you have your computer turned on at that time, and that
Schedule Pro is running.

Birthday Reminder
Lets say you have a friend whose birthday is on June 22, and you want Schedule
Pro to remind you of it. To have Schedule Pro display a birthday reminder on
your screen at 9:00 AM every June 22, follow these steps:

· Run Schedule Pro and click on the "New" button to create a new event.

· Type a name for this event - for example "Lorelei’s Birthday".

· Choose "Reminder" from the pop-up menu.

· Type the text of the reminder in the "Reminder" text box - for
example, "Call Lorelei and wish her a happy birthday".

· Click on the "Jun" button turn it on (and click on the buttons for any
other months that are selected to turn them off).

· Click on the "22" date in the day list (and click on the buttons for
any other days that are selected to turn them off).

· Click on the "Yearly" check box to turn it on.

· Enter the time of "9:00" in the time text boxes.

· Click on "Save" to save the reminder.

Schedule Pro will now remind you about the birthday at 9:00 AM on every
June 22. As before, your computer must be turned on and Schedule Pro must be
running for it to give you this reminder.

These are only two of the many possible uses there are for Schedule Pro.

1.21 Appendix: Troubleshooting

Appendix: Troubleshooting

This appendix lists some suggestions for dealing with the most common problems
you may encounter when using Quarterback. If you aren’t able to find the answer
to your problem here or elsewhere in the manual, please call or write to us for
assistance.

Our technical support address is:

Quasar Distribution
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Attn: Customer Support
PO Box 101
Vermont
Victoria 3133
Australia

Phone number:

+(613) 9887 2411

Fax number

+(613) 9887 2511

BBS number

+(613) 9587 5004

When Quarterback builds the file catalog it never stops counting files

This problem is caused by a drawer which has a "loop" in its directory
structure. Quarterback cannot get by the loop. You must first find the
directory causing the problem. Use the CLI commands "CD" and "List" to examine
the directories one by one until you find the one which never stops listing
files (you will see the same names going by over and over). Now use Quarterback
or the "Copy" program to backup the other good directories of the hard disk.
After you have saved all you can, try to delete all the files from the bad
directory and then delete the bad directory itself. If that fails, you may have
to format the hard disk and restore all files from your backup volumes.

Quarterback crashes when it reaches a certain file

This problem is caused by a form of directory corruption so severe that
AmigaDOS crashes while trying to read or write that file. To determine which
directory is causing the problem, carefully watch the Quarterback status screen
while the backup is running. Try to write down the complete directory path
which was displayed just before the crash. Then use the CLI "List" command to
examine that directory. Try to copy the files using the "Copy" command, if you
do not have them backed up elsewhere. Then delete the entire directory using
the "Delete all" command. If AmigaDOS continues to crash as you use these
programs, you might try repairing the damage with Quarterback Tools, available
separately from Quasar Distribution. Ultimately, if all else fails, format the
drive and restore from your backup volumes.

Insufficient memory

Quarterback itself is small, but when backing up a hard disk with many files
it may need a lot of memory to build the file catalog. If you experience
memory problems, you may need to terminate other programs, particularly
memory-resident utility programs.

Errors reading backup volumes during restoration

If Quarterback reports errors reading backup volumes while restoring, it may
not be able to restore one or more files from the affected volume. Quarterback
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attempts to restore as much of the affected files as possible, but all or part
of the files may be missing or contain useless data.

Locked files while restoring

Files which are locked by another program cannot be restored by Quarterback.
If necessary, terminate other programs which may be interfering. You may have
to re-boot your Amiga to unlock files which were left locked by another
program. Quarterback cannot unlock locked files.
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